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AAS17 Lease and HP Accounting 

The Fiscal Software AAA17 Lease, HP and Chattel Mortgage Accounting module helps 
you to keep account of financial leases, hire purchase contracts and chattel mortgages. 
 
It can account for both interest and GST apportionments, and also provides statistical 
and other financial data for a company's borrowings, by groupings and by financiers. 
 
You can also record assets for multiple clients or company entities. 
 

Licence 
All rights reserved. No part of this book may be reproduced or transmitted in any form or 
by any means, electronic or mechanical, including photocopying, recording, or by any 
information storage and retrieval system without written permission from Fiscal Software, 
except for the inclusion of brief quotations in a review. 
 
 
Copyright Fiscal Software 1995+ 
Windows - A trademark of Microsoft Corporation 
 
 
This book is designed to provide information on the installation and use of the Fiscal 
Finance program. Every effort is made to make this book complete and as accurate as 
possible. No warranty of suitability, purpose or fitness is implied. Fiscal Software shall 
have neither liability or responsibility to any person or entity with respect to any loss or 
damage in connection with or arising from the information in this book or from the use of 
the Fiscal Finance program. 
 
 
The copyright of the Fiscal Finance program prohibits you from copying the program for 
other than back up purposes. Distribution of this program to third parties is illegal and is 
in breach of copyright. 
 
 
This licence agreement entitles you to a non-exclusive right to use the program at a 
single site only. 
 
 
Multi users may use this program on a network system based at one location only. Sites 
that are remote from the main computer system must purchase an additional licensed 
copy of the software. 
 
 
If you do not agree with the copyright licence please return the program disks without 
loading them onto your computer along with all documentation for a full refund. Use of 
the program implies acceptance of the Copyright. 
 
 
Fiscal Software - A division of APY Nominees Pty Ltd ACN 009 018 393 
 

 

 



AAS17 Lease, HP and Chattel Mortgage Accounting – User Guide 4 

Copyright - Fiscal Software 

The program layout 

Menu and toolbar layout of the AAS17 program 
 

 
 
This is the menu and toolbar from which you can navigate through the whole program 
accessing all of it's features, and functions. 
 
The File Menu 
 

 
 
General Preferences - edit the current settings to customize your program and enter 
some default information. 
 
Toggle Colors On/Off - This allows users of older style terminal servers to avoid 
flashing colors on the screen. Older versions only allow for a 256 color palette. Newer 
versions do not need this setting 
 
Set Data Location - The program allows you to maintain a number of different data 
locations. For instance, you may wish to have a publicly accessible location, and one for 
private or confidential information. 
 
Merge Data Locations - In the event that you wish to join two or more data locations 
into one central data location, use this option. NB:Please note that it is important that 
you are the only user accessing the program at the time and that all other windows 
displaying data are closed. This is to ensure data integrity during the process. 
 
Print Setup - If you wish to set a printer, other than the default windows printer, as the 
printer to be used during that session, then select it here. 
 
File Manager - in the unlikely event of a data file being corrupted, this option allows you 
to perform file based tasks to try and recover your data. This should be used only with 
the advice of Fiscal Software. On, the subject of data corruptions, always backup your 
data. 
 
Exit - Exit the application 
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The Edit Menu 
 

 
 
Cut Copy and Paste - can be used to edit entry data. 
 
Browse Menu 
 

 
 
Browse Client and Assets/Contracts - this option opens the window containing you 
client data and their respective contracts. 
 
Financiers - this options is similar to the above, except that it is sorted by financiers, and 
contains different reporting features. 
 
Quick Calc Menu 
 

 
 
These menu items allow you to quickly calculate repayments for standard types of Hire 
Purchase and Lease contracts 
 
Reports Menu 
 

 
 
Chattel Mortgages, Hire Purchase and Lease sub options are noted at the end of this 
section. They are the same for each grouping. These menu items aer accessible when 
the Client and Asset/Contract window is open 
 
Individual Summary Reports - This create a report that contains summary information 
for the whole duration of the contract. It is suitable for storage for future use. 
 
Tagged Summary Reports - This allows you to tag what ever contracts you wish, so 
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that you can print a batch of individual summaries. 
 
Contracts Expiring Soon - This report shows what contracts and commitments are 
due, for a given time period. 
 
Cashflow Commitments - This report shows what the monthly cashflow commitment is 
for a given period. 
 
 

 
 
Amortization Table Single Asset - This report prints an amortization table for the 
selected contract. 
 
Amortization Table All Assets - This report prints an amortization table which 
incorporates all contracts of the given grouping (or items that are tagged). It does not 
include and individual data, just the accumulated values. 
 
Journals Single Asset - This report prints out standard journal entries for a contract, 
and also provides financial statement data for leases, to comply with AAS17 standards. 
 
Journals All Assets - This report prints out standard journal entries for all contracts of 
the given grouping (or items that are tagged). It does not contain any individual data, just 
accumulated values. It also provides financial statement data for leases, to comply with 
AAS17 standards. 
 
Summary Report All Assets Monthly - This prints a summary report on all the financial 
data for a given month. It includes individual data on each contract of the given grouping 
(or items that are tagged). 
 
Summary Report All Assets Annual - This prints a summary report on all the financial 
data for a given year end. It includes individual data on each contract of the given 
grouping (or items that are tagged). 
 
Window Menu 
 

 
 
This is the standard Windows menu for window organization - you will generally not need 
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it in this application 
 
Help Menu 
 

 
 
How to use Help - This displays a small window explaining how you can access help. 
 
Enter Registration Codes - This item allows you to register your program. This is 
covered in another topic. 
 
Check for Updates - This item calls a program that accesses information fro our web 
server to check to see if there is a more recent version of the software available. 
 
Visit the Fiscal Software Web Site - Click on this item to open a browser window to 
view the Fiscal Software web site. www.fiscal.com.au 
 
Tutorials on AAS17 Lease and HP Accounting - If you have installed the separate 
tutorial application, you can view flash tutorials on the use of the program. If you do not 
have the Tutorials installed, they are available for viewing on our web site. 
 
About AAS17 Lease Accounting - This item displays version numbers. 
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Clients and Assets/Contracts 

The Client and Asset/Contract Listings 
 

 
 
Click on the Clients Toolbar button to open the Client and Asset/Contract Listing 
 
or click on the respective Browse menu item 
 

 
 
This window is the main starting point for most of your dealings. 
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You will be able to add new clients and their respective assets/contracts from this 
window, and print most of the available reports. 
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The side menu 

The Side Menu 
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Window Side Menu 

  

 
 

 Close Window  

  
 
This menu item closes the Client and Asset/Contracts window. 
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Clients Side Menu 

  

 
 

 Add a Client  

  
 
Click here to add a new client. More on adding a new client 
 

 Change a Client  

  
 
Click here to change the details of a client. 
 

 Delete a Client  

  
 
Click here to delete a client. There are protections in place to prevent you deleting a 
client with transactions by accident. 
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Contracts Side Menu 

  
 
 
 

 Add a Contract  

  
 
Click here to add a new contract manually. 
 

 Add a Contract using the Wizard  

  
 
Click here if you wish to add a new contract using a self quided wizard. Usuallly, this 
suits simple contracts. 
 

 Change a Contract  
  

 
Clicking on this item allows you to access the contract details. Double clicking on the 
selected asset in the list box will also open that respective window. 
 

 Delete a Contract  

  
 
Click here to delete a contract. You will be prompted to confirm the deletion. 
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 View Archived Contracts  

  
 
View the archived asset records (not normally displayed) 
 

 View Contract Image  
  

 
Click here to view a copy of a scanned image of the contract. 
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Processes Side Menu 

  
 

 Process a Contract  

  
 
Click this button to select a contract to work on. Double clicking on the selected contract 
in the list box will also fire this event. 
 

 Payout a Contract  

  
 
Click on this menu item to record a sale or payout of a contract. This will regenerate the 
contracts financial details and recalculate interest and GST apportionments. 
 

 Sorted by XXXXXXXX  

  
 
Click on this menu item to change the sort order of the list box 
 

 Get Client Tags  

  
 
Click her to retrieve previously saved tags. You can tag contracts for later processing or 
printing. You can have as many saved tags as you wish. 
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 Store Client Tags  

  
 
Click her to save tags for later retrieval. You can tag and save combinations of contracts 
for later processing or printing. You can have as many saved tags as you wish. 
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Add/Edit Client Details 

  

 
 

 Client Name  

  
 
Enter the Client's name at this point. This is a required field 
 

 Financial Year End Day  

  
 
Enter the day number for the end of the financial year. The default value is 30. 
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 Financial Year End Month  

  
 
Enter the month for the end of the financial year. The default value is June. 
 

 Registered for GST  

  
 
Place a check in this item if the client is registered for GST 
 

 GST Accounting Method  

  
 
Select the GST accounting method of the client. 
 

 GST Lodgement Period  

  
 
Select the GST lodgement period for the client. This is not used at present. 
 

 Save Button  

  
 
Save the clients details. 
 

 Cancel Button  

  
 
Cancel any changes to a clients details. 
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Add/Edit an Asset/Contract General 

  

 
 

 Status Notice  

  
If you see the words "Not Yet Processed" it means that you have not yet entered all of 
the information necessary to process the financial data and determine an interest rate. 
These assets are excluded from reporting. Once you calculate the interest rate or view 
the amortization list, then the status message is removed. 
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 Client Name  

  
 
The clients name is automatically entered for you. 
 

 Contract Name  

  
 
Enter a name or description for the asset / contract. This can be whatever you wish 
 

 Contract Image  

  
 
You can attach a document, image, or pdf file to this record for later viewing. There is a 
lookup button to locate the file, and a red button to be able to view the file using the 
default viewer. 
 

 Loan Type  

  
 
Select the loan type. Each type has it's own differing reports, so that you can comply 
with the ATO requirements. 
 

 Financial Year End  

  
 
This information is automatically transferred from the client record. 
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 Financier Details  

  
 
You can associate the contracts with their financier. You can then view or print reports 
based on the financier. 
 

 Luxury Vehicle  

  
 
Check this box if the contract relates to a luxury vehicle. Hire Purchase and Chattel 
Mortgage contracts are affected if their value exceed the luxury vehicle depreciation 
limit. 
 

 Old Input Tax Credit Method  

  
 
Check this item if you have an old HP contract that initially used the payment value 
apportionment method, rather than the currently accepted liability paid method of 
apportionment. It is rare to use this after 2005. 
 

 Archive this Asset  

  
 
If you wish to save the details of a contract, but hide it from view, then check this box. 
You may wish to do this after the contract has been finalised, and to save space in your 
contract listings. 
 

 Contract Notes  

  
 
If you wish to add some notes about the contract, enter them in this field. 
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 Cancel Button  

  
 
Click this button to cancel and changes to data entered. 
 

 Save Button  

  
 
Click on this button to save your data. If a required field has been left blank it will alert 
you to this fact. 
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Process an Asset/Contract Worksheet 

  

 
 

 Subject to GST check  

  
 
Place a check in this field if the asset was subject to GST, so that the program can then 
calculate the GST apportionment. 
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 Able to claim input credits check  

  
 
Place a check her if you are able to claim input tax credits for GST paid on an asset. 
 

 Auto Calc GST check  

  
 
Place a check here to automatically calculate the GST as 1/11 of the cost of the asset, or 
1/11 of a lease payment. 
 

 Cost of the Asset  

  
 
Enter the amount financed or the full cost of the asset. Do not deduct any trade in's or 
deposits, as these are entered in the payments section. You can split the amount 
financed into the cost of the asset and any other charges that you may wish to identify 
separately. 
 

 GST Amount  

  
 
If you have checked the Auto Calc checkbox then this will be filled in automatically. If you 
do not have that box checked then you must enter the total amount of GST included in 
the asset cost. 
 

 Asset Apportionment  

  
 
You may add ilnes to represent different items that make up the amount financed, such 
as the cost of the asset, licence fees, insurances, etc, that all may have different GST 
values. If you do not wish to calculate the GST automatically, then remove the check 
from the checkbox field in the row. Then enter the amount of GST. You can use the 
Insert-Change-Delete buttons. 
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 Insert Change and Delete Buttons  

  
 
Click on these buttons to add, edit or remove any item that has been entered to make up 
the total cost of the asset/amount financed. 
 

 Acquisition Date  

  
 
Enter the date that the contract was signed. 
 

 Expected Life (Yrs)  

  
 
Enter the life of the asset in Years. This only applies to lease contracts for the purposes 
of AAS17 reporting. 
 

 Regular Payment Period  

  
 
Enter the regular payment period. If you choose Fortnightly, and you have a repayment 
regime that is irregular, then the processing time maybe increased. This does not apply 
to monthly repayments, where you can still have unusual repayment regimes. 
 

 Payment Listing  

  
 
Enter the repayment Regime. There must be a minimum of 3 lines. The first being what 
was paid on signing, the middle payments, and the final residual payment. See more 
about payment regimes here. 
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 Payment Buttons  

  
 
Use the Insert-Change-Delete buttons to record the regular payments, and use the up 
and down arrow buttons to move payments into the correct sequence. 
 

 Calc Interest Button  

  
 
Once you have entered the data, this button will calculate the effective interest rate for 
income tax purposes. 
 

 Interest Rate  

  
 
This field records the calculated interest rate. 
 

 Amortisation Button  

  
 
Click on this button to view (and print or export) the resultant amortisation table. 
 

 Journals Button  

  
 
Click on this button to view and print the resultant journal entries. 
 

 Save Button  

  
 

 Cancel Button  

  
 
Click on these buttons to save or cancel any changes made to your data. 
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Financiers 

The Financiers Listings 
 

 
 
Click on the Financiers Toolbar button to open the Financiers Listing 
 
or click on the respective Browse menu item 
 

 
 
This window is the starting point for your dealings in respect to financiers 
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You will be able to add new financiers and view their respective assets/contracts from 
this window, and print most of the available reports. 
 

The Side Menu 

The Side Menu 
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Financiers Side Menu 

  

 
 

 Add a Financier  

  
 
Click on this menu item to add a new financier. The listing of financiers will become an 
"edit in place" entry form. Just type in the new name. 
 

 Change a Financier  

  
 
Click on this menu item to change the financier name details. The listing of financiers will 
become an "edit in place" entry form. Just type in the changes required and press Enter. 
 

 Delete a Financier  

  
 
Click on this menu item to delete a financier. You will receive a warning before deletion. 
This will not delete the clients contracts. 
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Clients Side Menu 

  

 
 

 Filter Clients  

  
 
All the contracts associated with a financer will be displayed in the listing, if you wish to 
deal only with one client, then click on this menu item and the listing will be filtered to 
show only the currently selected client's records. 
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Reports Side Menu 

  
 

 Cashflow Monthly  

  
 
This report displays the cashflow for each month of a financial year. 
 

 Cashflow Annual  

  
 
This report displays a summary of the cashflow, interest, liability repaid and closing 
balances for a given financial year. 
 

 Cashflow YTD  

  
 
This report is similar to the Cashflow annual, but can be produced to record a summary 
as at a given date. 
 

 Amounts Outstanding  

  
 
This report displays the future cashflow commitments at a give month end. It also shows 
cashflow for each of the remaining financial years. 



AAS17 Lease, HP and Chattel Mortgage Accounting – User Guide 32 

Copyright - Fiscal Software 

 Monthly Amortisation  

  
 
This report displays the amortisation summary for all of the assets (or those tagged) at 
the end of a give month. 
 

 Contracts Expiring Soon  

  
 
This report provides details on all contracts that are due to be finalized over a given 
period of time. 
 

 Commenced or Finished  

  
 
This report displays all new contracts and all contracts that have been finalized during a 
financial year. 
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Quick Calcs 

Quick Calculations 
 

 
 
You can perform some quick calculations on what a repayment will be for a Hire 
Purchase contract or a Lease contract. 
 
Use the Quick Calcs Menu items to access the calculation windows 
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Calc Hire Purchase Repayments window 

  

 
 

 Principal  

  
 
Enter the principal amount to be financed 
 

 Interest Rate  

  
 
Enter the interest rate (annual) as a percent 
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 Number of Monthly Payments  

  
 
Enter the number of regular monthly repayments 
 

 First Payment  

  
 
Place a check in the box if the first payment was made on signing of the contract. 
 

 Residual %  

  
 
Enter the residual as a % - you can always enter an actual amount in the next field if 
preferred 
 

 Residual Amount  

  
 
Enter the residual amount - you can always enter a % amount in the previous field if 
preferred 
 

 Repayment  

  
 
This field displays the repayment once the Calc button is pressed. 
 

 Loan Name  

  
 
Once calculated, you can print out a loan repayment schedule (a print button will appear) 
Enter the name you wish to show on the report 
 

 Starting Date  

  
 
Once calculated, you can print out a loan repayment schedule (a print button will appear) 
Enter the starting date of the contract. 
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 CalcButton  

  
 
Press this button to calculate the repayment amount and to activate the print button. 
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Calc Lease Repayments window 

  

 
 

 Principal  

  
 
Enter the principal amount financed 
 

 Interest Rate   

  
 
Enter the annual interest rate as a percent 
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 Number of Payments  

  
 
Enter the number of regular repayments to be made 
 

 First Payment  

  
 
Place a check in the box if the first payment is made on the signing of the contract 
 

 Residual %  

  
 
Enter the residual as a % - you can always enter an actual amount in the next field if 
preferred 
 

 Residual Amount  

  
 
Enter the residual as an amount - you can always enter a percent % rate in the previous 
field if preferred 
 

 Repayment Amount  

  
 
This field displays the repayment amount once you press the Calc button. 
 

 Loan Name  

  
 
Once calculated, you can print out a loan repayment schedule (a print button will appear) 
Enter the name you wish to show on the report 
 

 Starting Date  

  
 
Once calculated, you can print out a loan repayment schedule (a print button will appear) 
Enter the starting date of the contract. 
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 Calc button  

  
 
Press this button to calculate the repayment amount and to activate the print button. 
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Setting the Data Location 

Setting the Data Location 
 

 
 

 
 
This menu item will allow you to add addition locations to store data, and also to change 
from one location to another. This is useful for situations where you might have a public 
access folder, but also require a private folder as well. 
 

 
 
You can insert, change and delete a data location, and also select the data location to 
use for this session, and future sessions. 
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If you click on the insert or change button the following window appears. 
 

 
 
Enter the root path into the path name field. - See below. 
 
The data is located in a folder in the following hierarchy 
 
Root Folder 
Sub Folder called Data 
Sub Folder Called AAS17 
 
ONLY enter the root folder path eg. C:\FIN6 
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General Preferences 

General Preferences 
 

 
 

 
 
This menu item opens the General Preferences window 
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Default Settings Tab 

  
 

 Financial Year End Day  

  
 
Enter the default end of financial year day (defaults to 30) 
 

 Financial Year End Month  

  
 
Enter the default end of financial year month (defaults to June) 
 

    Select Loan Wizard as default  

  
 
If you wish to use a wizard to enter the asset/contract data, in preference to manually 
then check this box. 
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 Luxury Vehicle Depreciation  

  
 
Enter the luxury vehicle depreciation limit for proper calculations of GST on HP and 
Chattel Mortgage contracts. 
 

 Cancel button  

  
 
Cancel any chnages made to data 
 

 OK button  

  
 
Save the data 
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Printing Tab 

  

 
 

 Print the Implicit Interest Rate on reports  

  
 
This allows you to choose if you wish to print the interest rate on reports 
 

 Print the Closing Balance on reports  

  
 
This allows you to choose if you wish to print the closing balance on amortisation reports 
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 Use PDF Previewer as default  

  
 
If you prefer to use a PDF viewer when viewing reports that will be turned into PDF files 
then place a check here. 
 

 Cancel button  

  
 
Cancel any changes made to the data 
 

 OK button  

  
 
Save the data 
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Colors Tab 

 

 

  
 

 Turn Colours Off  (for Terminal Server etc)  

  
 
If you experience flashing colors, then check this box to reduce the colors used in the 
program 
 

 Cancel button  

  
 
Cancel and changes made to the data 
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 OK button  

  
 
Save the data 
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Lists Tab 

  
 

 Clients Assets/Contracts List  

  
 
You can exclude some fields from appearing in the listings - uncheck any not required 
 

 Financiers Asset/Contracts List  
 

  
 
You can exclude some fields from appearing in the listings - uncheck any not required 
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 Cancel button  

  
 
Cancel and changes made to the data 
 

 OK button  

  
 
Save the Data 
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Merge Data Locations 

Merge Data Locations 
 

 
 

 
 
This opens the Merge Data window. NB - This function has the potential to lose data or 
corrupt data files if not used strictly in accordance with the instructions. Do NOT attempt 
this unless you are sure that all other users have logged out of the program. 
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If you are sure that you have complied with the instructions, you may click on the 
agreement button to commence the merging of two data locations. 
 

 
 
The source and target paths MUST be the actual folder where the data is located, Eg. 
C:\FIN5\DATA\AAS17 
 
The data is located in a folder in the following hierarchy 
 
Root Folder 
Sub Folder called Data 
Sub Folder Called AAS17 
 
Click on the Merge Data button to begin the merge 
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Tutorials 

Tutorials 
 
You can find video tutorials on our web site.  
 
Start with the Jumpstart tutorial to gain a quick overview of the programs main features, 
and then move to more specific ones if needed. 
 
Out web site is www.fiscal.com.au and the tutorials can be found by clicking on the "On 
Line Tutorials" menu item on the left hand side. 
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Frequently Asked Questions 

Frequently Asked Questions 
 
Over the life of the product, there has only been a few regular queries. We have listed 
them below. 
 
Q. I get an error 35 when I start the program. It relates to the GenPref file. 
A. Go to the file menu, click on the General Preferences menu, and when the window 
opens, click on the OK button to close it. This fixes the problem. 
 
Q. Can I transfer an asset to another client. 
A. Yes, Use Drag and Drop in the client/asset listing window. Click on the asset that is to 
be transferred and hold the left mouse button down, and then drag the mouse cursor to 
the hover over the new client name, in the client listing, and then release the left mouse 
button. 
 
Q. I have too may contracts listed that have now been finalized. How can I get rid of 
them. 
A. Rather then details the history of borrowings, you can archive the completed assets. 
Just set the archive flag in the asset properties. 
 
Q. I input all of the data, but the interest rate is not calculating. 
A. The most common mistake is to enter the total repayments in the amount financed 
field instead of the cost of the asset, or the net amount financed. This has the effect of 
making the total repayments = amount financed and therefore no interest is needed. The 
other possible problem is that the client properties does not have a financial year end 
date set. 
 
Q. The closing Balance is not being printed 
A. Click on the File Menu, and then on the General Preferences menu item. Then click 
on the printing tab, and then place a check in the appropriate checkbox. 
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Contacts 

Contacts 
 
You can contact Fiscal Software in a number of ways 
 
 
Email info@fiscal.com.au  
Web Site www.fiscal.com.au includes a "Contact Us" form 
Phone 08 9351 8878 Intl - +618 9351 8878 
Fax 08 9351 9989 Intl - +618 9351 9989 
Address PO Box 901 

Cannington WA 6107 
Australia 
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